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INTRODUCTION                                                                       STL Tonality - Lasse Lammert Plugin

Our team, along with Lasse Lammert have been hard at work developing, and designing a plugin we are all 
extremely proud of. We worked alongside Driftwood Amps, and the folks at Legendary Tones Hot Mod to bring you 
official models of their units in this plugin suite. 

Using the most advanced modelling algorithms, users can experience real-time simulations of Lasses go-to pedal, 
amp, and cabinet setups. Our software uses internal circuit simulations from the schematic’s of the specific amplifier’s 
Lasse uses every day. 

Designed by STL Tones, the Lasse Lammert Plugin Suite has been developed to capture every aspect of what 
makes Lasses guitar tones stand out. The plugin suite takes your direct input guitar signal all the way to a fully mixed 
guitar tone with its unique all-in-one design. 
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SYSTEM REQUIREMENTS                                                      STL Tonality - Lasse Lammert Plugin

• Low Latency Audio Interface (ASIO / Core Audio compatible). • High-Z (high impedance) instrument input. 
• Digital Audio Workstation (DAW) or a standalone plugin host. 

Windows requirements: 

• Windows 7 32/64 bit. 
• Intel Core 2 Processor Family or better. 

Mac requirements: • OS X 10.9.0 + 

• Intel Core 2 Processor Family or better. 

We recommend an Intel Core i5 processor or better for the best user experience.

During recording or monitoring we recommend a buffer size of 128 samples or lower, this is to minimize latency and 
improve the play through experience. This can be set in your audio interface setup utility or in your current DAW audio 
settings. 
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SUPPORTED HOST SOFTWARE                                            STL Tonality - Lasse Lammert Plugin

To use STL Tones software you need an audio host which can load VST, VST3, Audio Unit (AU) or AAX plug-ins. 

You can also run STL Tones software as a Standalone application. 

This plugin officially supports the following software host: 

Pro Tools 11 +: Mac & PC: AAX Native 

Logic Pro 9 & 10 (X) 64 bit: Mac: Audio Units 

Cubase 9 & 10: Mac & PC: VST/VST3 

Ableton Live 9 & 10: Mac: Audio Units/VST/VST3; Windows: VST/VST3 

Reaper 5.x: Mac: AU/VST/VST3; Windows: VST/VST3. 

This plugin comes in 64 bit format for both Mac and Windows, so it needs 64 bit hosts to function properly. 32 bit 
hosts and operating systems are not supported.
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RECOMMENDATIONS                                                             STL Tonality - Lasse Lammert Plugin

• Always use the high impedance (Hi-Z) input of your sound-card. This will ensure less noise and signal loss. Most 
real (pre)amplifiers and stomp boxes, have an input impedance of 1MegaOhm, so it would be a good idea to get a 
sound-card with 1MegaOhm input impedance to use this plugin. 

• Always make sure to have the highest input signal before the AD conversion, avoiding clipping. 

• Amp sims and stomp box simulators are not noisy, they do not add noise. In fact, they're a lot less noisy than real 
hardwares. If you have noise issues, check your guitar electronic circuit, cables and sound-card settings. 

• In almost all cases, amp sims and stomp box simulators don't introduce noticeable latency. STL Tonality doesn't 
introduce any noticeable latency. If you're experiencing latency issues, check your sound-card settings (specifically 
reduce the “Input Buffer Size to 128 samples”).  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iLok User ID & License Manager                                            STL Tonality - Lasse Lammert Plugin

STL Tones User Account -
In your STL Tones User Account, you will have access to your product installers, and latest software updates. To login 
to your user account, go to http://www.stltones.com and click the ‘Login’ button in the upper right-hand corner of the 
website. If you don't have a user account, please create one by clicking ‘Create Account’ inside the same login 
window. 

License Location - 
• In your STL Tones account you will have access to your product installers and latest updates. You can access your 

Activation License code within your user account on the www.stltones.com website, or via the email that got sent 
after purchase.  

• To login into your user account, go to http://www.stltones.com and click on the “Login” button in the upper right- 
hand corner. If you don’t have a user account, create one by clicking “Create Account” inside the same login 
window.
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iLok User ID & License Manager                                            STL Tonality - Lasse Lammert Plugin

Please create an iLok account by 
visiting http://www.ilok.com and 
download the latest version of the iLok 
license manager application. This will 
allow you to register your serial number 
and deposit your license to your 
computer or an iLok USB key. NOTE:- 
You DO NOT need an iLok USB 
Dongle in order to use this plugin. 
You can simply register your iLok 
license code to your computer that 
you intend to use the plugin. 

Install the iLok License Manager, 
open the program on your computer, 
and log in with the iLok User ID 
information that you created at http://
www.ilok.com. When logged in, a list of 
available destinations for license 
placement will be displayed under your 
User ID, such as your computer, or your iLok USB Keys. A list of all currently activated products will be shown in the 
main right list window. Inactive licenses will be shown in the “available” tab on the top. 

You can drag and drop licenses to deposit them in your computer or iLok USB Keys. 
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INSTALLATION & License Activation                                    STL Tonality - Lasse Lammert Plugin

• Run the provided installer which you will receive via email, follow the on-screen instructions given by the installation 
software. 

License Activation - 
The plugin won't be functional until you 
authenticate it with a valid iLok license. 

Follow these steps to complete the software 
activation. 

STEP 1 - 

After logging in to your iLok Account, click on the 
“Activate” button and go through the process to 
authorise your software.
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STEP 2 - Enter your serial number and if valid, green ticks will 

appear, as seen in the image below. 
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STEP 3 - If you haven’t yet created one, click on the ‘Create 

new account’ link, and you will be directed to ilok.com to create 

an account, which is free. 

STEP 4 - Here you will see all available locations to place your 

license. Select either your computer, iCloud, or iLok USB key.  
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STEP 5 - Successful Activation window will be next, confirming 

you have registered your product correctly.  
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MAIN INTERFACE                                                                    STL Tonality - Lasse Lammert Plugin

Footer Controls 

Input and Output Controls & Input Level 
Listener: 

Input will affect how much signal the plugin 
will receive. This will affect the amount of 
distortion range of the Gain pots in the 
Amplifier and Stomp Sections. Adjust 
according to your purposes and input signal 
levels. Output will affect how much signal 
the plugin will feed out to your DAW 
channel. Meters will show if input or output 
signal are clipping by appearing red. Next to 
the Input control, you will see a ‘bulb’ 

button. Click on this button to open the Input Level Listener. 
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Input Level Listener:
When you are not sure how to set the plug-in input level correctly, the Input Level Listener will ease the process for 
you.
Once you open the panel, the plug-in will listen to your input signal and adjust the Input Level accordingly.
The first thing you need to do is make sure the preamp level on your sound-card is set correctly.
For the Input Level Listener to work properly, it is advised to leave around 6dB of headroom on the A/D converter, 
which usually means having the sound-card input meter peaking below the "yellow" zone while playing normally. If the 
meter leds are yellow or red, turn the preamp level down until you're in the "green" zone.
Once your input signal is set correctly, select the Pickup Category from the menu:
- Low Output is for single coil or vintage pickups with low sensitivity
- Medium Output is for passive humbuckers with balanced output
- High Output is for active or hot passive humbuckers

Now start playing some riffs and the software will adjust the input level according to your guitar signal and the 
selected Pickup Category.
Here are some reference values you should see in the Input Level Listener if you've set everything correctly:
- Low Output pickup: Input Level in the -6dB to -3dB range
- Medium Output pickup: Input Level in the 0dB to +3dB range
- High Output pickup: Input Level in the +6dB to +9dB range

If you're seeing values that are clearly different from the reference level, adjust the sound-card preamp and repeat the 
process. 

Gate: Cuts unwanted noise spill, hiss or hum by setting a threshold at which the input signal need to be above for 
processing.  
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Tuner: Click to open the Tuner. The tuning indicator 
light will span from left to right and turn green when 
the note is in tune (middle position). When using the 
Tuner, you can switch off the output sound of the 
plug-in for convenience by clicking the speaker icon 
button on the bottom left size of the window. If you’re 
wanting to change the master tuning frequency to 
something other than 440Hz, you can do so by 
clicking on the text-box in 14 of 31 the bottom right 
side of the window. Keep in mind that the Tuner runs 
in a modal window, so all the other controls in Tonality 
are disabled until you close the Tuner window. 
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Stomp Section 

1) Equalizer: is a 7 band graphic eq, 
with a volume control. 

2) Liverkick OD: Lasse Lammerts 
signature overdrive pedal in plugin 
format. 

3) Lammert OD: This overdrive pedal 
is a staple to Lasse’s signature sound. 

Amp Select: Here you can select which of the 3 amp models you wish to use.
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Cabinet Section: Click to 
open the Cabinet view. In 
this section you’ll be able 
to change cabinet and 
microphone models. You 
are able to move the 
microphone around the 
speaker with 4 degrees of 
freedom: X (horizontal 
axis), Y (vertical axis), Z 
(distance) and W (angle). 
Each cabinet has been 
measured with each of the 
available microphones in 
more than 200 positions 
to achieve the ultimate 

realism and accuracy. In addition to moving the microphone around the speaker, you can further tweak your tone by 
using the featured Hi/Lo pass filters and Resonance control, change the volume of each microphone by using the 
related volume slider, flip the phase with the related button and set the mix of the 2 to find the perfect balance. It is 
also worth noting that changing the microphone distance introduces a slight delay in the output signal, resulting in 
phase cancellation that may help removing unwanted frequencies, so feel free to experiment. 

You can even switch off the cabinet by setting it to “Disconnected”. By doing so, the amplifier sound will pass through 
the cabinet section unprocessed. Clicking on the Cabinet button while the Cabinet view is open will bypass the 
cabinet section. 
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Tip 1: even if you can change the microphone distance and angle using the related knobs, all the 4 degrees of 
freedom are conveniently accessible directly via the crosshair by using key modifiers: left-clicking your mouse and 
dragging will move the microphone in the X/Y axis, left-clicking+ctrl and dragging will move the microphone on the Z 
axis, right-clicking and dragging will angle the microphone. 

Tip 2: as pointed out in the Amplifier section, each cabinet has its own impedance curve which is connected to the 
amplifier power section, but in Tonality you’re free to use 2 different cabinets at the same time. In such case, the 
impedance seen by the power amp will be the combination of the 2 impedances, so using the mix slider can help you 
achieve some very unique tones. 

Tip 3: in the cabinet menu you can also find a “Disconnected” option, what does it mean in terms of impedance seen 
by the power amplifier? Setting the cabinet to “Disconnected” will achieve the same result as connecting the amplifier 
to a purely resistive load, with the result of flattening the poweramp in terms of frequency response and reducing the 
poweramp controls (ex. Presence) excursion. 

Tip 4: setting the cabinet as “Disconnected” is not the same as bypassing the cabinet section entirely! This is 
extremely important to know when using Tonality with external IRs! If you bypass the cabinet section, the amplifier will 
keep seeing the load related to the selected cabinet(s) even if the cabinet and microphone are not processing the 
signal. If you change the cabinet when the cabinet section is bypassed you’ll still notice some differences in how the 
amp sounds and reacts, because you’re still changing the load connected to its poweramp. For the most transparent 
poweramp sound when using external IRs, you should set the cabinet as “Disconnected” and switch off the cabinet 
section. Feel free to experiment with various combinations to find some secret tones!
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EFFECTS SECTION                                                                 STL Tonality - Lasse Lammert Plugin

Equalizer: this is a 10 band 
graphic eq with additional level 
control, -12db to +12db of 
control, with additional ‘Thud’ 
and ‘Smooth’ controls. Thud: 
acts in the sub-lows region, 
60Hz and below. Smooth: 
attenuates the 6KHz area with a 
sharp notch. 

Delay: There are 9 controls for 
the Delay Pedal. 

Mix, which controls the mix of 
your signal, from 0-100%. 100% 
is for an equal mix. The dry 
signal always passes 
unprocessed, when the mix is at 
100%, the delayed signal has 

the same amplitude, therefore at 50%, the delayed signal is lower. Feedback, controls the feedback and repeats of 
the Delay. Time, which sets the delay time note. This value can be synced to the Daw by clicking the BPM Sync 
switch. You can also use the ’Tap’ button to Tap a specific delay time of your choice. Lo Pass, this controls the eq of 
the delay repeats from 1000Hz to 22050Hz. Hi Pass, this controls the eq of the delay repeats from 20Hz to 1000Hz. 
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Depth, this controls the modulation depth of the delay repeats from 0-100%. Rate, this controls the modulation rate of 
the delay repeats from 0Hz to10Hz. Ping Pong Switch: turns the “ping pong” delay effect On/Off. 

Reverb: There are 7 controls for the Reverb Pedal. Mix, which controls the balance of the dry and wet signal. Delay, 
controls the delay time before the reverberated signal appears. Length, which sets the time of the Reverb, from 
0-10seconds without temporal reference. Lo Pass, this controls the eq of the delay repeats from 1000Hz to 22050Hz. 
Hi Pass, this controls the eq of the delay repeats from 20Hz to 1000Hz. Depth, this controls the modulation depth of 
the delay repeats from 0-100%. Rate, this controls the modulation rate of the delay repeats from 0Hz to10Hz.
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AMP MODULES                                                                       STL Tonality - Lasse Lammert Plugin

AMP 1 - The Driftwood Purple Nightmare is a two 
channel, 6l6 powered, 100w guitar amplifier. Boasting a 
fully independent clean and ‘burn’ channel 
the Driftwood also includes its own green style overdrive 
pedal, mode and gain switches. The Purple 
Nightmare can do everything from driven rock to high 
gain metal tones.    

AMP 2 - Based on a Diezel™ Herbert™, this is a 
monstrous 180 watt Swiss Army Knife of an amp 
designed to cover everything from Country Music to 
Djent straight out of the box. Each channel has its own 
unique sound with channel 2 even having switchable 
gain levels. The Herbert also features a sharable mid-cut 
with makeup gain that allows for further detail when 
dialing in your tones. An incredibly versatile modern 
classic.  
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AMP 3 - Based on a Marshall™ JCM800™ 2203, which 
needs no introduction. This 100w beast has been the 
backbone of rock and metal since its inception in 1981. It 
has one channel of instantly recognizable British tone 
that can be dialed in for most mixes. Lasse’s own amp 
featured here is an original 1981 version with Siemens 
and RFT NOS tubes and is totally stock with the 
exception of the Legendary Tones Hot Mod. 
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HEADER CONTROLS                                                              STL Tonality - Lasse Lammert Plugin

Resize: click to resize the plug-in interface. 3 possible values are available: 50%, 75% and 100%. In addition to these 
3 modes, you can fine tune the size using the resize function in the bottom right corner 

Presets: click to manage the Tonality default and user settings. 
The Preset manager is divided into 3 sections: Load, Edit and 
Create. Under the Load section you’ll find all the available banks 
where each bank entry has a submenu featuring all the presets it 
contains. Under the Create section you can either add a Preset to 
the current Bank or create a new Bank entirely. When creating a 
new Bank, the currently loaded Preset will be copied into it, you 
can tweak it later using the Edit options. Tip: if you want to rapidly 
copy settings from one instance to another track in a DAW project, 
you can use the Edit > Current Preset > Copy function. This will 
store the settings in the clipboard, so you can move into your 
second instance and select Edit > Current Preset > Paste to paste 
the stored settings. 

Keep in mind that settings in the clipboard are preserved until there 
is at least 1 instance of Tonality available. If you close all the 
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instances and open a new one later, the clipboard will be cleared out and you won’t be able to paste. 

It is also worth noting that Copy/Paste only works between plug-ins of the same format: you can Copy/Paste from a 
VST3 to another VST3 or from an AU to another AU, but you can’t from a VST3 to AU, etc. 

Routing: click to change the routing of your virtual rig. Tonality supports 3 different routing modes: Mono, Mono/
Stereo and Stereo. Mono: all the rig sections will process the signal in Mono mode (this is the most CPU efficient 
routing) Mono/Stereo: all the rig sections will process the signal in Mono mode until an element supporting the “Mono-
To-Stereo-Split” is encountered. When this happens, the signal is split and the remaining elements in the chain will 
automatically switch to Stereo processing. Delay and Reverb are typical models supporting the “Mono-To-Stereo-
Split”, so when using those pedals in Mono/Stereo routing mode, the signal will be split and the subsequent effects 
will work in Stereo mode until the signal reaches the output. Stereo: all the rig sections are internally doubled and will 
process the signal in Stereo mode (this is the most CPU intensive routing) 

Tip 1: in the plug-in versions of Tonality, if the Routing menu only features the “Mono” option you’ve probably loaded it 
into a Mono track. Use a Stereo track if you want to unlock the other modes. 

Tip 2: in the standalone versions of Tonality, if the Routing menu only features the “Mono” option you’ve probably only 
set a single output in the Audio I/O settings. Enable at least 2 outputs from the Audio I/O menu, close the application 
and re-open it: you should now see all the Routing options available. 21 of 31 Routing Lock: click to lock the current 
Routing Mode. This control is useful when you want to audition different presets maintaining the routing untouched. 
Since the Routing Mode is saved in the Preset itself, loading a Preset may change it. If you want to avoid it, just 
activate the lock and it will be kept fixed until you unlock it, avoiding overrides. 
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SUPPORT                                                                                 STL Tonality - Lasse Lammert Plugin

For technical issues or any problems experienced with our software contact us via the contact page at  
www.stltones.com. Before doing so, follow our Troubleshooting questions below to see if these fix your issue. 

Support Information to be provided -  

In order to help us assist you the best way possible, please attach the following information to our support team: 
Product Version Number (e.g STL Tonality - Lasse Lammert, V1.0.0.)

Version number of your audio system (e.g ProTools 11.2.2, Logic 10.2.4) 
Interface/hardware (e.g. Focusrite Scarlett 2i2, Apogee Duet 2, etc.) Computer and operating system info (e.g 
Macbook Pro OS X 10.9.6, Windows 10 ver 1709, etc.)

Please include a detailed description of your problem.
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TROUBLESHOOTING                                                              STL Tonality - Lasse Lammert Plugin

Troubleshooting - 

Having issues with our software? 
Uninstall / Reinstall
This will repair possible broken permissions, fix corrupted files, and remove old versions of our software

Steps:
1) Close out of all host software (Pro Tools, Logic, Cubase, etc.)
2) Uninstall your plug-in.
3) Open your host software and ensure that the plug-ins no longer showing up in the inserts list. If the plug-ins are still 
present, locate the files on your computer and remove them manually. Once they no longer show up in your DAW 
(after restarting it), move on to step 4.
4) Close out of all host software.
5) Download the latest iLok License Manager application from iLok.com, install it, run the program and login with your 
iLok credentials.
6) Log into your STL Tones User Account and download the latest installers for the plug-in.
7) Run the latest installers and start your host program.
8) To confirm, ensure that your host program is reading the latest version of our software.
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TROUBLESHOOTING                                                              STL Tonality - Lasse Lammert Plugin

iLok synchronisation:
If you receive a message telling you to activate your licenses again, follow these steps.

Fix iLok connectivity:
If your iLok cannot connect to your computer, try plugging it in through a powered USB 2.0 hub – this will increase the 
likelihood that the iLok will connect to the computer. Once it is synched, it should be able to be plugged back into the 
computer’s USB port for use.

Repair your computer’s hard-drive:
Repair permissions on your computer.
Instructions: Mac & Windows

Run your host software as an administrator (Windows-only) :
This can fix a variety of issues that result in crashing or error messages on Windows DAWs that are loading our plug-
ins for the first time.

Steps:
1) Exit your host program (Pro Tools, Cubase, etc.)
2) Right-click on the icon for that host program and select “Run as an Administrator.” You will only have to do this 
once, meaning you can open up the host program normally the next time.
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TROUBLESHOOTING                                                              STL Tonality - Lasse Lammert Plugin

How do I find my plugin in Reaper?
If you cannot find your STL Tonality plugin in Reaper, follow these steps in order to make the plugin available.
Step1:
Download and install the latest version of iLok License Manager from iLok.com. After you install, open it and login 
with your iLok credentials. If you don’t have an iLok account, please create an account for free at iLok.com.
Step2: 
Now check if the plugin is installed on your computer in the default folder.

File Locations: MAC
VST: Macintosh HD/Library/Audio/Plug-ins/VST/STL Tonality Lasse Lammert
Note: The plug-in files are “Universal Binaries, which means that 32-bit and 64-bit plug-ins are included in the same 
file / Location.
File Locations: Windows
32-bit VST: C:\Program Files (x86)\Steinberg\VSTPlugins\STL Tonality Lasse Lammert
64-bit VST: C:\Program Files\VSTPlugins\STL Tonality Lasse Lammert

If you don’t find the respective files please reinstall your STL Tonality Product. If the relevant plugin files are in the 
above folder, perform a rescan:
In Reaper, press [Ctrl] + P (Windows) / [Cmd] + [,] (Mac) to access Preferences.
Go to Plug-ins > VST.
Under “VST Plugin Path,” make sure that the following path is listed (if not, add it):
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TROUBLESHOOTING                                                              STL Tonality - Lasse Lammert Plugin

Windows:
32-bit VST: C:\ Program Files (x86) \ Steinberg \ VSTPlugins \ STL Tonality Lasse Lammert
64-bit VST: C:\ Program Files \ VSTPlugins \ STL Tonality Lasse Lammert
Mac:
System HD > Library > Audio > Plugins > VST
Click on Clear Cache/Re-Scan. Create a new session with a supported sample rate, add a track and load your STL 
Tonality plugin. If the pop-up window tells you to activate please press “activate” button and insert your Full license 
serial code.

How do I find my plugin in Pro Tools?
If you cannot find your STL Tonality plugin in Pro Tools, follow these steps in order to make the plugin available.
Step1: download and install the latest version of iLok License Manager from iLok.com. After install, open it and login 
with your iLok credentials. If you don’t have an iLok account, please create an account for free at iLok.com.
Step2: check if the plugin is installed on your computer in the default folder.

VST: Macintosh HD / Library / Audio / Plug-ins / VST / STL Tonality Lasse Lammert
AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plug-ins /STL Tonality
Note: The plug-in files are “Universal Binaries, which means that 32-bit and 64-bit plug-ins are included in the same 
file/ Location.

File Locations: Windows
32-bit VST: C:\Program Files (x86)\Steinberg\VSTPlugins\STL Tonality
64-bit VST: C:\Program Files\VSTPlugins\STL Tonality
32-bit AAX: C:\Program Files(x86)\Common Files\Avid\Audio\Plug-Ins\STL Tonality
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TROUBLESHOOTING                                                              STL Tonality - Lasse Lammert Plugin

64-bit AAX: C:\Program Files\Common Files\Avid\Audio\Plug-Ins\STL Tonality
If you don’t find the respective files please reinstall your STL Tonality Product. If the relevant plugin files are in the 
above folder, perform a rescan:
To do a Rescan you need to delete certain files on your computer depending on your Pro Tools version. Please follow 
the official Avid website to do this.

Authorization Exception Error Message:

If this error message pops up, follow these steps:
Close your DAW (Pro Tools, Logic, etc.)
Go to iLok.com and download the latest version of the iLok License Manager application.
Run the iLok License Manager installer on your computer.
Restart your computer.
This issue only affects users who have not installed iLok License Manager 4.0.3 or later.

The plugin makes no sound at all, why is this happening? 

You have most likely not activated the software yet, or the license file has moved to a different location and the 
software can’t find it anymore. Please check the license activation window and double check that it still says you are 
registered. If not, simply redo the steps mentioned in the License Activation chapter.
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TROUBLESHOOTING                                                              STL Tonality - Lasse Lammert Plugin

Where do I find the installers?

You can download your plug-ins from your STL Tones account. Your account will display the installers and serial 
numbers for all of the STL Tones products you have purchased.

Where is the STL Tonality Plugin located on my computer? 

Mac:

AudioUnits: Macintosh HD / Library / Audio / Plug-ins / Components / STL Tonality - Lasse Lammert

VST: Macintosh HD / Library / Audio / Plug-ins / VST / STL Tonality - Lasse Lammert

AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plug-ins / STL Tonality - Lasse Lammert

Windows:

32-bit VST: C:\ Program Files (x86) \ Steinberg \ VSTPlugins \ STL Tonality - Lasse Lammert

64-bit VST: C:\ Program Files \ VSTPlugins \ STL Tonality - Lasse Lammert

32-bit AAX: C:\ Program Files(x86) \ Common Files \ Avid \ Audio \ Plug-Ins \ STL Tonality - Lasse Lammert

64-bit AAX: C:\ Program Files \ Common Files \ Avid \ Audio \ Plug-Ins \ STL Tonality - Lasse Lammert

Note: The plug-in files are Universal, so 32-bit and 64-bit plug-ins are included in the same file and location.
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